Introduction

Introduction
About This Manual

Install Guide

System Requirements
Installing Image Authentication Software
Starting and Exiting Image Authentication Software
Viewing the Instruction Manual
Software Updates
Uninstalling Image Authentication Software

Using Image Authentication Software

Screen Layout
Verifying Authenticity: Start Image Authentication Software
Verifying Authenticity: Start the Verification
Verifying Authenticity: Check the Results
Verifying Authenticity: Sort the Results
Verifying Authenticity: Delete Selected Results
Saving Verification Results
Menu List
Customer Support and Registration

Important: USB key

Keep the supplied USB key in a safe place. The USB key is required when using this software and cannot be replaced if lost.

Do not insert the USB key until installation of Image Authentication Software is complete. If the USB key is inserted before the software has been installed, a “Found New Hardware” wizard will be displayed; click Cancel to exit the wizard.

Important: Product Key

The product key may be found on the CD-ROM case. Do not lose this key. It is required when installing or upgrading this software and cannot be replaced if lost.
Thank you for your purchase of Image Authentication Software for use exclusively with Nikon digital single-lens reflex (SLR) cameras that support “Image Authentication,” which makes it possible to detect modifications to photographs after shooting.

This Install Guide includes information that you should know before using Image Authentication Software, such as how to install and start the software and how to view online help. Please read this guide thoroughly before installing the software.

Conventions

This manual assumes basic knowledge of cameras and Windows operating systems. Refer to the documentation provided with your computer or camera for more information. Where multiple menu items or folders are selected in sequence, the menu items are separated by a “>”.


Illustrations

The illustrations in this manual are from Windows XP. Depending on the operating system used, the dialogs and menus may differ slightly from those shown here. Some illustrations are composites.

Printing This Manual

To print this manual, select Print from the File menu in Adobe Reader. This manual is A5 size, allowing facing pages to be printed on one sheet of A4 paper (to print facing pages, start printing from an even-numbered page).

Installing/Uninstalling Image Authentication Software

Use an account with administrator privileges to install or uninstall Image Authentication Software under Windows XP and Windows 2000.
Customer Support and Registration

See Customer Support and Registration for more information.

Customer Support
Visit Nikon technical support web sites or view the ReadMe file.

Product Registration
Register your Nikon product on-line (Internet connection required).

Notices

• The copying or reproduction of copyrighted creative works is governed by national and international copyright laws. Do not use the camera for the purpose of making illegal copies or to infringe copyright laws. Do not use the camera in venues where photography or recording is prohibited.
• No part of the manuals included with this product may be reproduced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form, by any means, without Nikon’s prior written permission.
• Nikon reserves the right to change the specifications and performance of the hardware and software described in these manuals at any time and without prior notice.
• While every effort has been made to ensure that the information in these manuals is accurate and complete, we would appreciate it were you to bring any errors or omissions to the attention of the Nikon representative in your area (address provided separately).
• Nikon will not be held liable for any damages resulting from errors or omissions in these manuals or for incidental damages (e.g., photography-related expenses or lost profits) arising from defects in this product.

Trademark Information

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. Adobe Reader is a trademark of Adobe Systems, Inc. Pentium is a trademark of Intel Corporation. All other company names and product names mentioned in this manual or other documentation provided with your Nikon product are trademarks or registered trademarks of their respective holders.
About This Manual

How to Use This Manual

The pages of this manual are structured as shown here:

1. **Page title**
2. **Description**
3. **Blue underlined text** indicates a link to another part of this manual or the World Wide Web. Click the text to follow the link (note that a web browser and an Internet connection are required to link to the World Wide Web). To return to the previous topic, click the button in Adobe Reader or Adobe Acrobat Reader.
4. Click here to return to the first page.
**System Requirements**

Before installing Image Authentication Software, be sure that your system meets the following requirements:

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>Pentium 4, 1 GHz or better (or the equivalent) recommended</td>
</tr>
<tr>
<td><strong>OS</strong></td>
<td>Preinstalled versions of <em>Windows XP Home Edition</em> or <em>Windows XP Professional</em> (Service Pack 2 or later), or <em>Windows 2000 Professional</em> (Service Pack 4 or later)</td>
</tr>
<tr>
<td><strong>Hard-disk space</strong></td>
<td>50 MB required for installation, with an additional 200 MB required when Image Authentication Software is running</td>
</tr>
<tr>
<td><strong>RAM</strong></td>
<td>512 MB or more recommended</td>
</tr>
<tr>
<td><strong>Video resolution</strong></td>
<td>800 × 600 pixels or more with 16-bit color (High Color) or more</td>
</tr>
<tr>
<td><strong>Camera</strong></td>
<td>Nikon digital single-lens reflex (SLR) cameras that support Image Authentication</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td>One built-in USB port (for the USB key)</td>
</tr>
</tbody>
</table>

- Operation is not guaranteed when the key is connected via a USB hub.
- Check the support information at the web site below for the latest on compatible cameras and operating systems.

**Europe, Africa:** [www.europe-nikon.com/support](http://www.europe-nikon.com/support)

**Asia, Oceania, Middle East:** [www.nikon-asia.com](http://www.nikon-asia.com)

**U.S.A.:** [www.nikonusa.com](http://www.nikonusa.com)

Additional information may be available from the Nikon representative in your area. Visit [http://nikonimaging.com/](http://nikonimaging.com/) for contact information.
Before installing Image Authentication Software:

- Confirm that the computer satisfies the System Requirements for Image Authentication Software.
- Exit any other applications that may be running, including anti-virus software.
- Do not plug the supplied USB key into a USB port.

Starting the Installation

Use an account with administrator privileges when installing Image Authentication Software.

1. Place the Image Authentication Software CD-ROM into the CD-ROM drive.

2. A “Select Region” dialog will be displayed. Select a region and click Next.

If the “Select Region” Dialog Is Not Displayed

To display the “Select Region” dialog, select My Computer from the Start menu (Windows XP) or double-click the My Computer icon on the desktop (Windows 2000) and double-click the CD-ROM (Authentication) icon in the My Computer window.

Existing Versions of Image Authentication Software

If an existing copy of Image Authentication Software is detected during installation, a notification will be displayed. Follow the on-screen instructions.
3 The Install Center window will open. Click Easy Install.

Other Options in the Install Center Window

Instruction Manual: Open the Manuals folder on the installer CD. Double-clicking Index.pdf displays a list of languages; click a language to open this instruction manual.

Try: Download trial versions of Nikon software (Internet connection required).

Customer Support: View the ReadMe file or visit Nikon technical support websites (Internet connection required).

Product Registration: Register your Nikon product on-line (Internet connection required). Not available in some regions.
4 Click **Next**.

5 After reading the license agreement (1), select **I accept the terms of the license agreement** (2) and click **Next** (3) to proceed with installation.
6 Enter the **product key** (1) found on the CD case and click **OK** (2).

7 Personalize your copy of Image Authentication Software (1) and click **Next** (2).

**Product Key**

*Do not lose this key.* It is required when installing or upgrading this software and cannot be replaced if lost.
8 The destination folder for Image Authentication Software will be displayed under “Install Image Authentication Software to.” Click **Next** to install Image Authentication Software to this folder, or click **Change...** to select another destination.

9 Click **Install**.
10 Click Finish.

11 Click Yes and remove the Image Authentication Software CD-ROM from the CD-ROM drive.

If a dialog box is displayed directing you to restart the computer, follow the on-screen instructions.

This completes the installation of Image Authentication Software.

See Uninstalling Image Authentication Software for information on uninstalling Image Authentication Software.
Starting Image Authentication Software

The supplied USB key is required when starting Image Authentication Software. Do not remove the USB key while the software is running.

1. Insert the supplied USB key into a USB port. Connect the key directly to the computer; do not use a USB hub or keyboard.

Some computers may need some time to recognize the USB key when it is first connected. Wait for a “Found New Hardware” message before proceeding to Step 2.

Windows XP

The “Found New Hardware” message is displayed in the task bar.

Windows 2000

The following dialog is displayed.

The USB Key

Removing the USB key while the software is running may interrupt operation for up to five minutes. If the key is removed while the software is running, reinsert it into the same USB port. Do not lose the USB key.
Starting and Exiting Image Authentication Software  2/2

2 Start Image Authentication Software using either of the methods described below.

   Method 1: Double-click the Image Authentication Software shortcut on the desktop.

   Method 2: Click Start and select Image Authentication Software > Image Authentication Software from All Programs (Windows XP) or Programs (Windows 2000).

Exiting Image Authentication Software

1 Select Exit from the File menu.

2 If you need to remove the USB key from the USB port, be sure to keep it in a safe place.
Viewing the Instruction Manual

To view the Image Authentication Software instruction manual, select **Display Instruction Manual…** from the **Help** menu (Adobe Acrobat Reader 5.0 or later required).
Software Updates

Image Authentication Software is equipped with an automatic update function known as Nikon Message Center. Nikon Message Center checks for updates to a variety of Nikon digital products, including Image Authentication Software. If the computer is connected to the Internet, Nikon Message Center will automatically check for updates when Image Authentication Software starts. You can also check for updates by selecting Check for Updates… from the Help menu. If an update is available, an update dialog box will be displayed.

Downloading Software Updates

An Internet connection is required to download software updates. The user bears all applicable fees charged by the Internet service provider or telephone company.

Dial-up Connections

When using a dial-up connection, be aware that the connection is not automatically terminated when download is completed. Be sure to terminate the connection manually.

Privacy Policy

Information provided by the user as part of this service will not be given to third parties without the user’s permission.
Uninstalling Image Authentication Software

When uninstalling Image Authentication Software, use an account with administrator privileges and remove the USB key from the USB port.

1. Click **Start** and select **Image Authentication Software > Image Authentication Software Uninstall** from the program list.

2. Click **Yes** to begin removing Nikon View Pro and all of its components.

3. If uninstaller encounters read-only files or components shared by another application, a confirmation dialog will be displayed. Read the information displayed carefully before deciding what to do with the affected components.

4. Click **Finish**. If directed to restart the computer, follow the on-screen instructions.
Using Image Authentication Software

The layout of the Image Authentication Software window is described below.

1. **Menu bar**: Click a menu name to display menu items.
2. **Toolbar**: Provides quick access to frequently-used options.
3. **Result area**: Verification results are displayed in this area.
4. **Preview/progress area**: Preview the images selected in the result area and view verification progress.
5. **Status bar**: Lists the number of images selected in the result area, or when no images are selected, the total number of images in the result area.

<table>
<thead>
<tr>
<th>Image File Name</th>
<th>Information</th>
<th>Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0014.TIF</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information has been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0015.MFF</td>
<td>OK</td>
<td>OK</td>
<td>The Image Data has been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0011.JPG</td>
<td>NG</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0012.JPG</td>
<td>OK</td>
<td>NG</td>
<td>The Image Data has been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0013.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0014.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0015.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0016.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0017.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
<tr>
<td>C:\Documents and Settings\User\My Documents\My Pictures\DSC_0018.JPG</td>
<td>OK</td>
<td>OK</td>
<td>The Image Information and Data have been changed.</td>
</tr>
</tbody>
</table>
Starting Image Authentication Software

**Controls used**

Insert the USB key into a USB port, then double click the application shortcut or select the application from the **Start** menu.

Be sure the USB key is inserted in a USB port before starting Image Authentication Software. Double-click the Image Authentication Software shortcut on the desktop or click **Start** and select **Image Authentication Software** > **Image Authentication Software** from **All Programs** (*Windows XP*) or **Programs** (*Windows 2000*). The Image Authentication Software window will be displayed.
Verifying Authenticity

Start the Verification

Controls used Drag and drop files or folders into the result area

Drag and drop the files or folders to be verified into the result area (1). A progress indicator will be displayed in the preview/progress area. Verification results are displayed in the result area (2) as verification is completed for each file.

2 Preview: Previews of the images selected in the result area are displayed here.
3 File path: The full file names and paths for selected images are displayed here.
4 Search progress: The folder currently being searched and search progress for the file currently being verified.
5 Verification progress: The name of the file currently being verified and overall verification progress.
6 Suspend: Click to end verification and display the results for the files that have been verified to this point. Verification can not be resumed once suspended; to restart verification, select the folder containing the images to be verified.
### Sub-folders
At default settings, the contents of sub-folders in the folders selected for verification will also be verified. To exclude images in sub-folders, select **Options**... from the **Tools** menu and uncheck **Search Subfolders**.

### Selecting Folders
In addition to the drag-and-drop option described on the preceding page, folders can be selected by clicking **Choose Image Folder** in the toolbar or by selecting **Choose Image Folder**... from the **File** menu and selecting folders in the “Browse for Folder” dialog. Note that individual files can not be selected for verification using this method.

### Supported File Formats
Image Authentication Software supports JPEG, TIFF, and NEF (RAW) formats. Images in other formats can not be verified and will not be displayed in the result area.

#### NEF (RAW) + JPEG
NEF (RAW) and JPEG images recorded at image qualities of NEF (RAW) + JPEG are treated as separate files for the purposes of verification.

### Renaming Files
Renaming files does not affect verification results.
Check the Results

Verification is complete when the progress bar is no longer displayed. The results are displayed in the result area as follows:

1. **Image File Names**: The names of the files that have been verified.

2. **Information**: The results of verification checks performed on Exif data and other photo information. **OK** is displayed if no information has been changed, **NG** if information has been changed, and **?** if the authenticity of the information could not be determined.

3. **Data**: The results of verification checks performed on the actual image data. **OK** is displayed if the image has not been changed, **NG** if the image has been changed, and **?** if the authenticity of the image could not be determined.

4. **Description**: Detailed verification results and errors are displayed here.

5. **Preview area**: Preview the images selected in the result area. Double-click the preview to open the image in the default application for images of the selected type.

**Display Full Path**

The **Display Full Path** option in the **View** menu is used to choose whether the full file path is displayed in the **Image File Name** column.
## Verifying Authenticity

### Verification Results

Verification results are displayed as follows:

<table>
<thead>
<tr>
<th>Text color</th>
<th>Information column</th>
<th>Data column</th>
<th>Description column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>OK</td>
<td>OK</td>
<td>Not displayed</td>
<td>Image data and image information have not been changed.</td>
</tr>
<tr>
<td>Red</td>
<td>OK</td>
<td>NG</td>
<td>The Image Data has been changed.</td>
<td>Image data have been changed.</td>
</tr>
<tr>
<td>Red</td>
<td>NG</td>
<td>OK</td>
<td>The Image Information has been changed.</td>
<td>Image information has been changed.</td>
</tr>
<tr>
<td>Red</td>
<td>NG</td>
<td>NG</td>
<td>The Image Information and Data have been changed.</td>
<td>Both image data and image information have been changed.</td>
</tr>
<tr>
<td>Red</td>
<td>NG</td>
<td>?</td>
<td>The Image Information was changed. Whether the Image Data was changed cannot be determined.</td>
<td>Image information has been changed; authenticity of image data can not be determined.</td>
</tr>
<tr>
<td>Yellow</td>
<td>?</td>
<td>?</td>
<td>Detection Error</td>
<td>Memory insufficient or unable to verify image information.</td>
</tr>
<tr>
<td>Yellow</td>
<td>?</td>
<td>?</td>
<td>Unsupported File</td>
<td>File is not in JPEG, TIFF, or NEF format or file extension is not “.JPG”, “.TIF”, or “.NEF”.</td>
</tr>
<tr>
<td>Yellow</td>
<td>?</td>
<td>?</td>
<td>Changed File or Unsupported File</td>
<td>Image was created with camera that does not support image authentication.</td>
</tr>
<tr>
<td>Yellow</td>
<td>?</td>
<td>?</td>
<td>Image Authentication Function is OFF.</td>
<td>Image was taken with Off selected for Image Authentication in camera setup menu.</td>
</tr>
</tbody>
</table>
Verifying Authenticity

Sort the Results
To sort results in ascending order by Image File Name (1), Information (2), Data (3), or Description (4), click the column name. Click again to sort in descending order.

Delete Selected Results
To delete verification results for a selected file, select it in the Image File Name column (5) and click Delete (6) or press the Del key (the associated image file will not be deleted). To select multiple results, press Ctrl while clicking the file names, or press Shift while selecting two file names to select these files and all results in between.
Using Image Authentication Software

Saving Verification Results

Controls used
The **Save Results** button

To save verification results, click **Save Results**. A “Save As” dialog will be displayed; choose a destination and file name and click **Save**. Results are saved in a generic “.csv” (Comma-Separated Values) format supported by many spreadsheet and word-processing applications. The fields are ordered as listed in the result area: full file path followed by verification results for photo information and image data, with the description coming last.

![Image Authentication Software](image)

**Important: Altering Verification Results**

Note that verification results saved in “.csv” format can be altered and consequently cannot be used to guarantee of image authenticity.
### Menu List

#### File Menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose Image Folder</td>
<td>Ctrl + I</td>
<td>Select folders for verification.</td>
</tr>
<tr>
<td>Save Results</td>
<td>Ctrl + S</td>
<td>Save verification results.</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt + F4</td>
<td>Exit Image Authentication software.</td>
</tr>
</tbody>
</table>

#### Edit Menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Delete</td>
<td>Delete selected verification results.</td>
</tr>
<tr>
<td>Select All</td>
<td>Ctrl + A</td>
<td>Select all verification results.</td>
</tr>
</tbody>
</table>

#### View Menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Full Path</td>
<td>Check this option to display full file paths in the result area.</td>
</tr>
</tbody>
</table>

#### Tools Menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options…</td>
<td>Choose whether to verify images in subfolders.</td>
</tr>
</tbody>
</table>

#### Help Menu
<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Instruction Manual…</td>
<td>F1 View this manual.</td>
</tr>
<tr>
<td>Check for Updates…</td>
<td>Check for software updates.</td>
</tr>
<tr>
<td>About Image Authentication Software…</td>
<td>View software version information.</td>
</tr>
</tbody>
</table>
Thank you for choosing Nikon, and welcome to our family of Digital Imaging products.

We are confident your Nikon product will meet and exceed the high level of quality, reliability and innovative design you have come to expect from Nikon.

Please contact us if you have any questions or suggestions. We value your feedback, and want to be sure you are completely satisfied with your purchase. To assist us in serving you better, we ask that you please register your product on-line at www.prodreg.com/nikon.

If you have any questions or suggestions about Nikon Digital Imaging products, please call the Nikon Digital Imaging Hotline:

1-800-NIKON-UX (1-800-645-6689)

Technical Support............24 hours a day, 7 days a week
Other Services..................Mon. through Fri., 10am to 10pm EST

Technical support for your Nikon Digital Imaging product is free. Support for computer related issues is free for either six or twelve months from the date of your first call to Nikon, depending on your product. Please ask our Customer Service Representative for details. Also, visit our technical support web site at www.nikontechusa.com for FAQs, software updates, manuals and solution forums. Information on other exciting Nikon products is available at www.nikonusa.com.

Technical support and repair services is only available in the United States, the Caribbean, and South and Central America. If you are in this service area but cannot reach our toll free number, please call 1-631-547-4311. Software and other items cannot be shipped outside of this service area.

Thank you for choosing a Nikon Digital Imaging product.
Nikon User Support Information (Users in Other Areas)

If you are in need of technical assistance with the installation or operation of your Nikon product(s), please do not hesitate to contact one of the following Nikon representatives. When calling support, you will be asked to supply the serial and/or version number(s) of your Nikon software. For efficient communication, it is highly recommended that you have your Nikon product in front of you.

Europe and Africa

Austria
Nikon GmbH
Modcenterstr. 14, A - 1030 Wien
Tel: +43-(0)900-150066
Phone line costs (# 0,45€/min)

Belgium
H. De Beukelaer & Co. N.V./S.A.
Boomsesteenweg 77, B-2630 Aartselaar
Tel: +32-(0)-3-870-59-00 Fax: +32-(0)-3-877-01-25

Czech Republic
Nikon SRO
Kodanska 46, 100 10 Praha 10
Tel: +420-267-154-560

Denmark
Nikon Nordic AB, dansk filial
Ørestads Boulevard 67, 1, DK-2300 København S
Tel: +45-32452000

Finland
Nikon Nordic AB Suomen toimisto
Ojahaanrinne 4, 01600 VANTAA
Tel: +358 9 5660 060

France
Nikon France S.A.S.
191, Rue du Marché Rollay, 94504 Champigny
Sur Marne Cedex
Tel: +33-(0)8-25-82-10-10

Germany
Nikon GmbH
Tiefenbroicher Weg 25, 40472 Düsseldorf
Tel: +49-(0)-900-1225564
Phone line costs (# 0,24 €/min)

Greece
D. & J. Damkalidis S.A.
44 Zefyrou St. 17564
Tel: +30-210-9410888 Fax: +30-210-9427058

Hungary
Nikon Kft.
Budapest, Fóti út 56. 1047 Hungary
Tel: +36-1-232-13-71

Italy
Nital S.p.A.
Via Tabacchi 33, 10132 Torino
Tel: +39-199-12-41-72 Fax: +39-011-81-44-233

Netherlands
Inca Import B.V.
Rutherfordstraat 7, 2014 KA Haarlem
Tel: +31-(0)23-5101910 Fax: +31-(0)23-5243551

Norway
Nikon Nordic AB NUF
Martin Linges vei 17, 1367 Snarøya
Tel: +47-67-82-74-00

Poland
Nikon Polska Sp. z o.o.
ul. Postepu 14, 02-676 Warszawa
Tel: +48-22-6079400

Rep. of South Africa
Foto Distributors, Head Office
Nikon House, 516 Kyalami Boulevard,
Kyalami Business Park, Midrand 1685.
Tel: +27-(0)11-466-2500 Fax: +27-(0)11-466-3400

Russia
Nikon Europe BV, CIS Representative Office
Zubarev pereulok, d.15, k.1, office 541, 129164 Moscow
Tel: +7 (095) 733 91 70

Spain
Finicon S.A.
C/Ciencias, 81 Nave-8, Poligono Pedrosa
08908 L’Hospitalet de Llobregat, Barcelona
Tel: +34-(0)93-2649090 Fax: +34-(0)93-3363400

Sweden
Nikon Nordic AB
Anton Tamms väg 3, 194 22
Upplands Väsby
Tel: +46-(0)-8-594-109-00

Switzerland
Nikon A.G.
Im Hanselmaa 10, CH-8132 Egg Zurich
Tel: +41-(0)848-277-000

United Kingdom
Nikon U.K. Ltd.
380 Richmond Road, Kingston, Surrey KT2 5PR
Tel: +44-(0)870-770-0231
Asia, Oceania, Middle-East and Canada

<table>
<thead>
<tr>
<th>Country</th>
<th>Code</th>
<th>Address</th>
<th>Phone Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>AU</td>
<td>Maxwell Optical Industries Pty Ltd. Unit F1, Lidcombe Business Park 3-29 Birnie Avenue, Lidcombe NSW 2141 Tel: +61-(0)2-8748-5200 Fax: +61-(0)2-8748-5220</td>
<td></td>
</tr>
<tr>
<td>Canada</td>
<td>CA</td>
<td>Nikon Canada Inc. 1366 Aerowood Drive, Mississauga, Ontario L4W 1C1 Tel: +(1)-(0)905-625-9910 Fax: +(1)-(0)905-625-6446</td>
<td></td>
</tr>
<tr>
<td>China</td>
<td>CN</td>
<td>Beijing Hua Xun Nikon Service Center 57, Xuanwumen Xidajie, Beijing 100803 Tel: +86-(0)10-6307-4142 Fax: +86-(0)10-6307-4122</td>
<td></td>
</tr>
<tr>
<td>Hong Kong</td>
<td>HK</td>
<td>Nikon Hong Kong Ltd. Suite 1001, 10F, Cityplaza One, 1111 King’s Road, Taikoo Shing Tel: +852-(0)2902-9000 Fax: +852-(0)2907-0378</td>
<td></td>
</tr>
<tr>
<td>India</td>
<td>IN</td>
<td>Photo Vision 223, Okhla Industrial Estate Phase III, Near Modi Flour Mill, New Delhi - 110 020 Tel: +91-(0)11-2692-8913 Fax: +91-(0)11-2692-9856</td>
<td></td>
</tr>
<tr>
<td>Indonesia</td>
<td>ID</td>
<td>Pt Alta Nikindo Kompleks Mangga Dua Square Block H 1&amp;2 Jl.Gunung Sahariraya, Jakarta Utara 10730 Tel: +62-(0)21-6231-2700 Fax: +62-(0)21-6231-2777</td>
<td></td>
</tr>
<tr>
<td>Israel</td>
<td>IL</td>
<td>Hadar Photo Supply Agencies Ltd. 36 - 38 Achad Haam St., Tel-Aviv P.O. Box 1686 Tel: +972-(0)3-5603947 Fax: +972-(0)3-5603905</td>
<td></td>
</tr>
<tr>
<td>Korea</td>
<td>KR</td>
<td>Nikon Imaging Korea Co., Ltd. 12th Floor, Seoul Chamber Of Commerce &amp; Industry Building, 4-45, Namdaemoon-Ro, Jung-Ku, Seoul 100-743 Tel: +82-(0)2-6050-1800 Fax: +82-(0)2-6050-1801</td>
<td></td>
</tr>
<tr>
<td>Lebanon</td>
<td>LB</td>
<td>Gulbenk Trading Co. Hamra-Makdessi Street, Adhami Building, 5th Floor, Beirut P. O. Box 113-6645 Tel: +961-(0)1-353742 Fax: +961-(0)1-347613</td>
<td></td>
</tr>
<tr>
<td>Malaysia</td>
<td>MY</td>
<td>Nikon (Malaysia) Sdn. Bhd. 11th Floor, Block A Menara PKNS No. 17, Jalan Yong Shook Lin 46050 Petaling Jaya Selangor Darul Ehsan Tel: +60-(0)3-7809 3688 Fax: +60-(0)3-7809 3600</td>
<td></td>
</tr>
<tr>
<td>New Zealand</td>
<td>NZ</td>
<td>T.A. Macalister Ltd. 65-73, Parnell Rise, Auckland Tel: +64-(0)9-303-4334 Fax: +64-(0)9-309-6502</td>
<td></td>
</tr>
<tr>
<td>Philippines</td>
<td>PH</td>
<td>Columbia Global Photo Sales Corporation #129-135 Gregorio Roxas Street, SFDM, Quezon City, 1117 Tel: +63-(0)2-363-8550 Fax: +63-(0)2-364-3334</td>
<td></td>
</tr>
<tr>
<td>Singapore</td>
<td>SG</td>
<td>Nikon Singapore Pte. Ltd. 80 Anson Road #10-01/02 Fuji Xerox Towers Singapore 079907 Tel: +65-6559-3618 Fax: +65-6559-3665</td>
<td></td>
</tr>
<tr>
<td>Taiwan</td>
<td>TW</td>
<td>Lin Trading Co., Ltd. 8F, 272 Nagking Road, Sec. 3, Taipei 10566 Tel: +886-(0)2-2740-3366 Fax: +886-(0)2-2781-2525</td>
<td></td>
</tr>
<tr>
<td>Thailand</td>
<td>TH</td>
<td>Niks (Thailand) Co., Ltd. 166 Silom Road 12, Bangkok 10500 Tel: +66-(0)2-235-2929-39 Fax: +66-(0)2-236-7240</td>
<td></td>
</tr>
<tr>
<td>Turkey</td>
<td>TR</td>
<td>Teleoptik Ltd Sti Ankara Caddesi Dedehan No. : 118-120, Kat : 1-2, Sirkeci 34112, Istanbul Tel: +90-(0)212-527-0789 Fax: +90-(0)212-520-6716</td>
<td></td>
</tr>
<tr>
<td>U. A. E.</td>
<td>AE</td>
<td>Grand Stores, L.l.c. Saleh Bin Lahej Building, Mezzanine Floor, Al Garhoud, Deira, Dubai P. O. Box 2144 Tel: +971-(0)4-2823700 Fax: +971-(0)4-2828382</td>
<td></td>
</tr>
</tbody>
</table>

Please visit the web site appropriate for your area of purchase for downloads of updated software, replacement manuals and technical support information:

Europe and Africa  
[http://www.europe-nikon.com/support/](http://www.europe-nikon.com/support/)

Korea  
[http://www.nikon.co.kr](http://www.nikon.co.kr)

Asia Pacific Area  
[http://www.nikon-asia.com](http://www.nikon-asia.com)

Nikon Imaging Global Site  